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Upon completing this course, you will be able to: 

• Record information about your location prior to working in the field 

• Modify and add to default information to tailor WIMS to your project 

• Transfer images and records from the desktop PC to the handheld and back 

• Map weeds in the field using ArcPad 

• Update weeds records when you return to the office 

• Share weeds information with your colleagues 
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 To open WIMS: 

1. Double click on the WIMS icon on your desktop. 
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Having several records for unknown species can help you when you are mapping in the 
field.  If the weed you are mapping is not found in the WIMS database, you can use one 
of these unknown records in the field and make changes in the WIMS desktop when 
you return. 

 To access the screen where you add the unknown plants: 

1. On the Main Menu, click the Support Tables button. 

2. Click the Plants (summary) button on the Supporting Tables Maintenance 
screen. 

3. Click the New button on the Plant Descriptions/Weed Definitions screen.  You 
are now at the Plant Descriptions/Plant Maintenance screen. 

 To add the unknown plants: 

1. Enter Unknown 1 in both the Plant Scientific Name and Plant Common 
Name fields on the Plant Descriptions/Plant Maintenance screen. 

2. Click the Save and Close button. 

3. Repeat the previous two steps to enter two more unknown plant records - 
Unknown 2 and Unknown 3. 

4. Press the Refresh Display button after entering your data to see the new 
information. 

5. Click the Close button on the Plant Descriptions/Weed Definitions screen. 

6. Click the Close button on the Supporting Tables Maintenance screen to return 
to the Main Menu. 
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In the context of WIMS, an area is a uniquely named parcel of land that may have either 
legally-defined boundaries or locally-derived place names.  It is used to indicate your 
location that you will work in while mapping weeds.  A defined “area” can refer to a 
singular site (of any size or shape). Or the “area” named can be used to indicate a 
larger site with multiple smaller sites/areas/units nested within it, as we will do in this 
class. 

 To access the screen where you create an area record: 

1. On the Main Menu, click the Find/Create Areas button. 

2. On the Find Areas screen, click the New Areas button to access the Area 
Definition screen. 

 To enter an area record: 

1. Enter what you will call your parcel of land in the Area Name field. 

2. In the Area Type field, click the drop down arrow and select the appropriate 
category for the land parcel. 

 

You must select a value from the list using your mouse in order for the 
information to show up in any reports. Do not use your keyboard to choose 
the value or type information into the field. 

3. In the State field, click the drop-down arrow and select the state in which the 
land parcel is located. 

4. Select the appropriate county from the drop-down list in the County field. 

 

 

If there were any restrictions on activities for the land (no pesticides 
permitted, etc.), you would enter that information in the Restrictions field. 
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5. Select the appropriate ownership type from the drop-down list in the Ownership 
field. 

 

 

If you select an area type other than TNC site, at least one additional field 
would appear below the Ownership field.  Here you would designate a 
specific individual as the owner or point of contact. 

6. Click the Save And Close button at the top of the screen when finished entering 
all information. 
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Having an image of the site where you are managing your weeds is beneficial to 
recording weed data in the field.  It allows you to see your exact location. 

You can request an image of the location where you will map weeds information from 
the GIS Specialist for your region.  When requesting an image, be sure to specify that it 
be done in the following format. 

Datum: WGS84 or NAD83 ONLY 
(no NAD27) 

Projection: Decimal degree or UTM 

Image 
format: 

Images can be in .sid, .gif, .jpg, .jp2, .png, .tif, .bmp or CADFG 
format.  See the ArcPad 7 Manual for details.  

Size: 50MB or smaller is recommended 

 To prepare to move the image: 

1. Check the time and date on the desktop PC and handheld.  Ensure they are the 
same otherwise data may be lost. 

2. Place the handheld in the cradle if not already there. 

3. Check that the ActiveSync icon down in lower right of the desktop screen 
(near the clock) is green.  This indicates the ActiveSync connection is active. 

4. If the ActiveSync connection is inactive, go the handheld and tap the Windows 
Start button at the top left of the screen with the stylus.  Select ActiveSync.  
Once ActiveSync opens, tap the Sync button.  The ActiveSync icon down in 
lower right of the desktop screen should now be green. 

5. Determine if ArcPad is open on the handheld.  Check this by looking for the 
ArcPad icon in the lower right of the handheld screen. 
 
If ArcPad is open on the handheld, close it.  Tap the Start button on the 
handheld.  Select the ArcPad icon. Then choose File, then Exit at top of the 
ArcPad application. 
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Always be sure to close ArcPad before transferring files from your desktop 
to your handheld or from your handheld to your PC.  If you do not close 
ArcPad, your files may become corrupt during the transfer process. 

Another step to take in avoiding corruption of the file is to ensure that your 
ActiveSync connection is not continuous.  This way you avoid accidental 
transfer of data. 

 To transfer the image: 

1. In ActiveSync on your desktop, click on the Explore button. 

 

 

If ActiveSync is not open on your desktop, you can access it from the 
Windows Start button on your desktop PC, then choose Programs and 
then select Microsoft ActiveSync.   Alternately, you can double click on 

the ActiveSync icon  at the bottom right of your screen. 

2. Select My Computer under the Other Places portion of the screen on the left. 

3. Double click on the c:\ drive to see the contents of the drive. 

4. Navigate to the WIMS folder and double click to view its contents. 

 

 

If your folders are not all grouped together, you may find it helpful to go to 
the View menu and choose Arrange Icons by and then select Type to 
correct this.  Your folders will now all be listed together, in alphabetical 
order.  

5. While holding down the Control key, click on the .sid, .sdw and .prj files 
indicated by your instructor to select all three. 

6. From the Edit menu, choose Copy.  

7. Select My Computer under the Other Places portion of the screen on the left 
again. 

8. Navigate to Mobile Device.   

9. Navigate to My Pocket PC, then the SD Data folder and then the WIMS folder. 

10. From the Edit menu, select Paste. 

The files will now be transferred to your handheld. 
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Once your area and unknown plant records are set up in the WIMS desktop, you will 
want to move your files from there to your handheld.  This is done via GIS Export. 

 To perform a GIS Export: 

1. On the Main Menu, click the GIS Export button.  

2. Once again follow the steps in the To prepare to move the image section above. 

3. On the Introduction tab of the GIS Export window, click the Proceed button.  
You will advance to the Choose Areas tab. 

4. Select one of the Areas you just created.  Click Continue.  You will then be at 
the Specify Plant screen. 

5. Click the Continue button.  You are now at the Choose Data Type tab. 

6. Under Choose Outputs, ensure all three boxes (Occurrence, Assessment, and 
Treatment) are checked. 

7. Under Choose coordinate datum, select WGS84 UTM (northern 
hemisphere) as the projection for the image we just transferred is based on 
UTM Zones.  An area marked Zone Options then appears on the screen. 

8. Choose Force Zone and enter the value your instructor provides in this box. 

 

 

If the projection for the image you acquired from your GIS contact is in 
decimal degrees rather than UTM, you would instead select WGS84 
Decimal Degrees for Step 7 and you would skip Step 8 below.  You can 
determine the projection of your image by opening the corresponding .prj 
file for the image in Notepad. 

9. Click the Continue button. You will now be on the Data Type Options tab. 

10. Keep the defaults for each section of this screen (Occurrence, Assessment and 
Treatment Options). Click Continue. 

11. On the Specify Date range tab, click Continue.  You will now be at the Go for 
it? tab. 
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12. Ensure the Export shapefiles to my ArcPad handheld PDA box is checked 
and press the Create Shapefile button. 

13. Click Yes at the Confirm GIS Export Parameters window. 

14. Click Close to leave the GIS Export window. 
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 To open the image in ArcPad: 

1. Tap the Add layer button  on the main toolbar. 

2. Tap twice (double tap) on SD Card to show all layers that are available on the 
SD Card. 

3. Select the .sid image file indicated by your instructor.  The image will then 
appear on your screen. 

 

 

Don’t see an image on your screen at this point?  It might just mean you 
are viewing white space off to the side of the image.  Click the Zoom Full 

Extent button  and you should see your image. 

4. To zoom in on a portion of the map, tap the Zoom button .  Then tap the part 
of the image that you want to magnify. 

 

 

You can also magnify a select portion of the map by tapping your stylus on 
the upper left boundary of desired part of the map and dragging it toward 
the lower right boundary of the area you want to see in detail. 

To zoom out, tap the arrow next to the Zoom button  and select Zoom 
Out then tap the image. 
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 To add your WIMS data layers to your image: 

5. Tap the Add layer button  on the main toolbar. 

6. Tap twice (double tap) on SD Card to show all layers that are available on the 
SD Card.  

7. Tap twice on WIMS to show all layers that are available within the WIMS folder 
on the SD Card.  

8. Tap in the box in front of WeedassessmentsL.shp, WeedassessmentsP.shp, 
Weedoccurrences.shp, WeedtreatmentsL.shp and WeedtreatmentsP.shp to 
select these five layers.  A red check mark will appear in each box. 

9. Tap OK.  After a while, you will then see the image on your handheld. 

 

It takes a while for ArcPad to process your request and load the shapefiles.  
Near the end of the process you will see a progress icon on your screen. 
Once that icon disappears, your shapefiles are loaded.  At that point, you 
may tap on the screen.   

Do not tap on the screen while ArcPad is loading your shapefiles (or is 
working to execute any type of task in general).  If you do, you will see a 
Redraw Interrupted by User message in red at the top of your handheld 
screen.  This indicates you interrupted ArcPad as it was executing a task.  

You may need to press the Refresh button  on the main toolbar and 
request the task again (repeat Steps 7 and 8 in this case). 

10. Tap the WIMS key button  on the WIMS toolbar (just to the right of the 
words TNC Weeds Database).  The five buttons to the right of the WIMS key 

button ( ) should no longer be greyed out. 

11. Tap the Layers button  on the Main toolbar. The layers window now 
appears on the left side of your screen. 

12. Check to be sure that you only have one of each of the following layers - 
WeedassessmentsL.shp, WeedassessmentsP.shp, Weedoccurrences.shp, 
WeedtreatmentsL.shp and WeedtreatmentsP.shp. In other words, each should 
appear only ones in the list of layers in your image. 

13. Tap the OK button to close the Layers window. 

 



12  Recording Weeds in the Field 

 

 Weed Information Management System (WIMS)  © 2007, The Nature Conservancy 

 To activate your GPS: 

1. For handhelds with separate GPS units, be sure the GPS is inserted into the 
memory card slot or connected by cable. 

2. In ArcPad, tap the GPS Tools button . 

3. A window will appear that reads “The GPS is not active.  Would you like to 
activate it now?  Tap Yes on this window. 

4. The GPS Position Window appears allowing you to view the GPS unit's 
progress in obtaining satellite fixes. 

 

 

You can close this window by tapping the x in the upper right corner of the 
window. 

5. Once you obtain a GPS fix, you will be able to see your location on the map with 

the symbol. 
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Having some trouble with your GPS unit?  Try these options. 

ArcPad cannot find your GPS unit:  In this case, tap the drop-down 
arrow next to the Tools button and select FindGPS.  FindGPS is an 
extension for ArcPad that was loaded during the ArcPad installation.  Once 
your GPS is active, it automatically detects the GPS.  And, if no GPS is 
found, various messages are displayed to assist you in diagnosing the 
problem. 

Note: You can also manually search for your GPS unit by scrolling through 
the different COM ports in ArcPad (Tools > Options > AUX). 

A no projection files error message appears after activating your 
GPS:  You don’t have any shapefiles loaded. 

The GPS unit is not functioning properly:  Refer to the Troubleshooting 
the Pharos GPS Unit document in the WIMS User manual. 

 

 To deactivate your GPS: 

1. Tap the drop-down arrow next to the GPS Tools button . 

2. Select GPS Active. 

The GPS unit becomes inactive.  Notice the red square no longer appears around the 
GPS Active icon.  This is a visual indicator that the GPS has been deactivated. 

 

Always be sure to deactivate the GPS before turning off the handheld. 
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Your handheld is on.  ArcPad is open and you see your map.  Your GPS is active.  
You’re now ready to start mapping weeds! 

You start with the occurrence record.  The occurrence is the basic unit for mapping and 
assessing a singular weed or weed population/infestation.  Each “occurrence” defines a 
single species of any infestation size and is recorded at a specified location. 

 To take a GPS reading: 

1. Walk to the middle of the weed patch. 

2. Tap the WIMS Key on the WIMS Toolbar.  The five buttons to the right of 

this (Occurrence, Assessment and Treatment - ) should 
now be active. 

3. Tap the Occurrence button  on the WIMS Toolbar. 

4. Tap the Capture GPS Point button  on the Edit/Draw toolbar that now 
appears.  The latitude and longitude of your weed location will be captured and 
stored in WIMS. 

The Weed Occurrence form will appear, allowing you to record additional information. 

 To Create an Occurrence Point Manually (using the Stylus): 

1. Zoom-in as much as possible on your imagery 

2. Follow steps #2 and #3 (above) to activate the Occurrence button. 

3. Tap the Point button ( ) on the Edit/Draw toolbar, then tap on the screen 
where your weed patch is located.  

The Weed Occurrence form will appear, allowing you to record additional information. 
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 To complete the Basic Tab of the Weed Occurrence form: 

1. Tap the black drop down arrow next to the Weed field with your stylus to see the 
species list. Choose the scientific Weed name (by tapping it with your stylus) 
from this list. If a common name for this weed was entered in database, it will 
also appear in the grey area below your selection. 

2. Tap in the Location field. Enter a short but specific occurrence identifier (e.g.  
Stand 1, Stand 2, River Mile 6) or written description of the occurrence location 
to assist you in pinpointing the location of this group of weeds and to distinguish 
this occurrence from other occurrences. 

 

 

You can access the keyboard from the lower right of your handheld to 
facilitate entry of text in WIMS forms. 

3. Tap in the You field.  Enter your first and last name to indicate you are the 
individual who created the weed record. 

4. Select the black drop down arrow in the Accuracy field and select the 
appropriate accuracy for the GPS unit you are using. 

5. Tap the Areas tab at the top of your screen. 
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 To complete the Area Tab: 

1. Tap the black drop down arrow in the Area 1 field and select the option 
indicated by your instructor. 

2. Check the Primary Area box under this field. 

3. Tap the black drop down arrow in the Area 2 field and select the option 
indicated by your instructor. 

4. Tap the Description tab. 

 To complete the Description Tab: 

1. Ensure the Active box is checked.  This should happen automatically.  It 
indicates this is a new occurrence that you will be tracking. 

2. Fill in any additional information you may have. 

3. Tap the OK button to save your entries. 

The Weed Occurrence form will close and you will be back at your image. 

 

 

To view the weed occurrence form you just completed, tap on the red dot 
on the map for your new weed occurrence and tap the Get Info button 

 in the main toolbar.  The completed Weed Occurrence form will 
appear.  This process also works for weed assessment and treatment 
records as well.  

Once you create other records (assessments and treatments), you may 
find it difficult to use the Get Info feature to access data on the record you 
desire.  To ensure you get information for the correct record, use the 
Layers window to control the layers you are viewing.  Tap the Layers 

button  to access this window and then tap the red checkmarks in the 
box in front of the layer title (in the column with the eye).  This will cause 
you to view only the record type you desire. Tap OK to close this window.  
Then you can follow the steps above to view the record.  
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In the world of WIMS, an assessment is a measure (either qualitative or quantitative) of 
the spatial extent of a particular weed occurrence.  Several assessments (assessment 
records) can be compiled over time for a particular occurrence to determine whether the 
weed manifestation is changing and if so, how.  Taken together, these assessments 
over time are also called monitoring. 

A treatment is any management activity that occurs at a specific time over a defined 
geographical area, with the purpose of controlling and managing weed populations, or 
as part of an overall integrated weed management program.   

There are four methods of capturing the location for assessment and treatment records. 

• Stopping at key points (vertices in a polygon) along the way and taking GPS 
readings at each point 

• Walking and recording simultaneously around the area (also using the GPS) to 
create a polygon 

• Walking a straight line and taking a GPS reading at the start and end to create 
a line 

• Using your stylus to draw in an assessment or treatment record 

We’ll talk about the first three in light of assessment records and the last regarding 
treatment.  Let’s take a look at the first one now. 

 To stop at key points along the way and take GPS readings at each point: 

1. Walk to a spot at the perimeter of your weed patch. 

2. Make sure that your GPS unit is active. 

3. Make sure that the WIMS Key button on the WIMS toolbar is still depressed 
and the Assessment button near it is active. 

4. Tap the Assessment  or Treatment  button on the WIMS toolbar. 

5. Tap the Polygon button  on the Edit/Draw toolbar. 
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6. Tap the Add GPS Vertex button  on the Edit/Draw toolbar to begin 
recording your location. Remain in position for several seconds, until the 
countdown progress bar at the bottom of the Vertex window disappears. 

7. Walk either clockwise or counterclockwise to another spot along the perimeter. 

8. Tap the Add GPS Vertex button  again. Notice the red line on your screen 
connecting the two vertices. 

 

 

You can better view your line connecting your two vertices by zooming in 
to your image. 

9. Repeat steps 7 and 8 until you have at least 3 vertices recorded on your map. 

 

 

You must have at least 3 vertices for your assessment record to be saved.  
The more vertices that you add, the greater the accuracy of your record.  
This applies to treatment records as well. 

10. At the last spot on the perimeter, press the Proceed Arrow button .  WIMS 
will then complete the polygon, connecting your last vertex with your first. 

The Weed Assessment or Treatment form will appear, allowing you to record additional 
information. 
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 To create an assessment or treatment record by walking continuously 
around the area: 

1. Walk to a spot at the perimeter of your weed patch. 

2. Make sure that your GPS unit is active. 

3. Make sure that the WIMS Key  button is still depressed and the buttons near 
it are active. 

4. Tap the Assessment  or Treatment  button. 

5. Tap the Polygon button . 

6. Tap the Add GPS Vertices Continuously button  to begin recording your 
location. 

7. Walk completely around the perimeter of your weed patch, following your 
progress on the map. 

8. When, according to your map, you appear to be back at the beginning, tap the 

Proceed Arrow button  to finish recording the polygon. 

9. Complete information in the weed assessment or treatment form according to 
those instructions in the Creating an Assessment or Treatment Record: 
Recording Details sections below. 
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 To create an assessment or treatment record by walking a straight line to 
create a Line record (for instance, when walking along a road or ditch): 

1. Walk to a spot at the perimeter of your weed patch. 

2. Make sure that your GPS unit is active. 

3. Make sure that the WIMS Key  button is still depressed and the buttons near 
it are active. 

4. Tap the Assessment Line  or Treatment Line  button 

5. Tap the PolyLine button . 

6. Tap the Add GPS Vertex button  on the Edit/Draw toolbar to begin 
recording this line. Remain in position for several seconds, until the countdown 
progress bar completes 

7. Walk to the end of the line, then tap the Add GPS Vertex button  again. 

8. Next, tap the Proceed Arrow button  to finish recording the weed line. 

9. Complete information in the weed assessment or treatment form according to 
those instructions in the Creating an Assessment or Treatment Record: 
Recording Details sections below. 



Recording Weeds in the Field 21 

 

 

© 2007, The Nature Conservancy  Weed Information Management System (WIMS) 

 To draw in the assessment or treatment record by using the stylus: 

1 Zoom in to your map as much as possible 

2 Make sure that the WIMS Key  button is still depressed and buttons near it 
are active. 

3 Tap the Assessment  or Treatment  button. 

4 Tap the Polygon button . 

5 Use your stylus to trace the perimeter of the assessment or treatment polygon by 
first tapping the screen on the perimeter of your weed patch, then single-tapping 
along the edge of that polygon to outline the patch.  

6 Once you have finished tracing the existing shape, press the Proceed Arrow 

button  to finish recording the polygon. 

The border of the assessment or treatment record is now apparent on your image, 
and the Weed Assessment or Treatment form will appear, allowing you to record 
additional information. 
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 To complete the Location Tab on the Weed Assessment form: 

1. Use the pull-down menu next to the Choose Occurrence field to select the 
weed occurrence you just created to establish a link with that record. 

 

If you have only one occurrence recorded, you will notice that this 
occurrence will automatically default into the display for the field.  
However, you must still complete Step 1 and select the occurrence from 
the pull-down menu (the second item listed). 

 

 

 

The scientific name of the weed (Weed field) and the name of the 
person/people who recorded the weed occurrence (Crew field) appear 
automatically once you select the occurrence. 

2. Tap in the Notes field.  Enter any helpful information using the keypad. 

3. Tap in the You field.  Use the keyboard to enter your first and last name. 

4. Tap the Size tab. 

 To complete the Size Tab: 

1. Tap the Calculate size from shape box so that it becomes checked.  WIMS 
automatically determines the area of the assessment and records it in the Area 
(in ac) field. 

2. Tap the black right arrow key at the top of the screen to advance to the 
Cover/Density tab. 

3. Tap the Cover/Density tab. 
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 To complete the Cover/Density Tab: 

1. Record the amount of overall area that the weed covers in the ‘Cover’ Info 
section of the window.   
 
To record an exact amount, enter the number in the Percent field.  For an 
approximate amount, instead select the closest range of percentages from the 
Class field. 

 

 

Rather than complete the ‘Cover’ Info to indicate the percent of vegetative 
cover, you could instead indicate the week or stem density in the Density 
portion of the screen.  Both cover and stem density can measure changes 
over time.  Which one you choose depends on the species and your 
monitoring objectives Your instructor will talk you through how to use 
density instead of cover on this tab. 

 

2. Tap the Stats tab. 

 To complete the Stats Tab: 

1. Tap in the Comments field. Enter information regarding the status of the weed 
Occurrence whereby phenology may impact your treatment activities. 

2. Tap the black drop down arrow in the Phenology field and select the 
appropriate developmental stage of the weed as indicated by your instructor.  

3. Tap the black drop down arrow in the STTrend field and select the Short Term 
Trends that is appropriate for the population of that weed Occurrence.  If the 
trend is not known, select “unknown.   

4. Tap the black drop down arrow in the LTTrend field and select the Long Term 
Trends that is appropriate.  If the trend is not known, select “unknown. 

5. Tap the black drop down arrow in the Distribution field and select the formation 
that is appropriate. 

6. Tap the Time tab. 

 To complete the Time Tab: 

1. Tap in the Start Time field. Using the keyboard, enter the time you began your 
assessment. 
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Time must be recorded in ArcPad using military time (based on a 24 hour 
clock) with no colons between the hour and minute.  For example, 9:00 AM 
must be entered as 0900 while 3:30 PM gets recorded as 1530. 

2. Tap in End Time field.  Enter the time you finished with the assessment. 

3. Enter 1 in the # Staff field to indicate you, a single staffperson, are the only 
person involved in this assessment. 

4. When you are all done filling-out the Assessment Record, tap OK.  

The Weed Assessment form will close and you will be back at your map.  Notice the 
border of your assessment record is now apparent and surrounded by a dashed line.   
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 To complete the Basic Tab on the Weed Treatment form: 

1. Tap the black drop down arrow with your stylus next to the Treatment Type and 
select the appropriate method. 

2. Note today’s date defaults in the Date field.  Confirm this is correct. 

3. Tap in the You field and enter your name from the list to indicate you recorded 
the treatment. 

4. Tap in the Crew field. Using the keyboard, enter your name to indicate you 
performed the treatment. 

5. Tap in the Notes field.  Using the keyboard, enter details regarding the 
treatment. 

6. Tap the Area/Weed1 tab. 

 To complete the Area/Weed1 Tab: 

1. Tap the black drop down arrow in Area Treated field and enter what your 
instructor tells you. 

2. Tap the Calculate size from shape box so that it becomes checked.  WIMS 
automatically determines the area of the treatment and records it in the Area 
Treated field. 

3. Tap the black drop down arrow in the Weed1 field and select the weed 
occurrence you created in the previous exercise.  The scientific name of the 
weed automatically fills into the Name field. 

4. Tap the black drop down arrow in the Phen field and select the developmental 
stage of the weed at the time of treatment. 

5. Tap in the % field. Enter the approximate or actual percentage of the weed 
Occurrence that is being/has been treated. 
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6. Tap the black right arrow to advance to the Time tab. 

7. Tap the Time tab. 

 To complete the Time Tab: 

1. Tap in the Start Time field.  Using the keyboard, enter the time you began your 
assessment. 

 

 

Keep in mind the format to be used - military time with no colons. 

2. Tap in the End Time field.  Enter the time you finished with the assessment. 

3. Tap in the # Staff field.  Enter 1 to indicate you, a single staffperson, are the 
only person involved in this assessment. 

 To complete the remainder of the treatment form: 

1. Tap the right arrow at the top of your screen to advance to the appropriate tab 
for the method used to treat the weeds (Mechanical, Chemical, Herb1, Herb2, 
Fire, Graz and Bio).   

2. Tap that tab. 

3. Complete all fields on that screen. 

4. Tap OK. 

The Weed Treatment form will close and you will be back at your image.  Notice the 
border of your treatment record is now apparent and surrounded by a dashed line.   
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Once you have finished mapping your weeds in the field using ArcPad, you need to 
transfer the files from the handheld back to the WIMS desktop.  This is done via a GIS 
Import using the WIMS desktop. 

 To complete a GIS Import: 

1. Follow the steps in To prepare to move the image under the Transferring an 
Image from your Desktop PC to Your Handheld section above.  

2. On the Main Menu in the WIMS desktop, click the GIS Import button. 

3. On the GIS Import tab of the Import ESRI Shapefile window, ensure the option 
labeled Import form ArcPad version of Weeds Database is selected. Click the 
Next button.  You will advance to the ArcPad Import tab. 

4. In the ArcPad Import Options portion of the screen, ensure that Retrieve data 
directly from my Pocket PC/ArcPad unit is selected.   

5. In the Data to Import portion of the screen, ensure all three items (Weed 
Occurrence, Assessment and Treatment) are checked.  Click Import ArcPad 
Data. 

Your data should now be in the WIMS Access database on your desktop PC. 
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 To locate your occurrence record: 

1. On the Main Menu in the WIMS desktop, click the Find/Create Occurrences 
button. 

2. Click the black drop down arrow in Area Name field. 

3. Select the area used to create your occurrence record. 

4. Click the Find Weed Occurrences button. 

 To update the occurrence record: 

1. Review all the information you had entered in the field to ensure it is accurate. 
Be sure to check both the required information on the left side of the screen as 
well as the Location Info and Characteristics tabs on the right. 

2. Fill in any information you may have now that you didn’t have when initially 
creating the record out in the field. 

3. Uncheck the unaudited box. 

4. Click the Save and Continue button. 
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Since all Assessments are tied to a specific Occurrence, you first need to find the Occurrence 
record that relates to that Assessment before you can find the specific Assessment record. 

 To locate your assessment records 

1. From your occurrence record, click the Details button in the Assessment 
portion of the screen (bottom left). 

You will be at the first weed assessment record associated with that weed occurrence. 

 

 

Alternately, you could look at a list of all assessments first and then 
navigate to an individual assessment record from there.  To view the list 
off all assessments associated with an occurrence, you would use the List 
button instead in the Assessment box. 

 To update the assessment records: 

1. Review all the information you had entered in the field to ensure it is accurate. 
Be sure to check both the top portion of the screen as well as the Status, 
Measurements and Lat/Long tabs in the bottom part of the screen. 

 

Note the time format in the WIMS desktop is different than in ArcPad.  
Here time is entered in standard format with a colon between the hour and 
minute. 

2. Fill in any information you may have now that you didn’t have when initially 
creating the record out in the field. 

3. Ensure the Current box is checked. 

4. Click the Next button to advance to the next assessment associated with that 
occurrence record. 

5. Repeat steps 1 – 3 for your second assessment. 

6. Click the Save and Close button to return to the Main Menu. 
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Since the treatment record you created in the field is also tied to a specific occurrence, 
you first need to find the Occurrence record as you did when locating your assessment 
records. 

 To locate your treatment record: 

1. Locate your weed occurrence as you had in the steps above. 

2. In the Treatments portion of the screen, click the Details button. 

 

 

For locating treatment records not associated with a weed occurrence, see 
Section 1.44 – Finding an existing Treatment Record of the WIMS User 
Manual 

 To update the treatment record: 

1. Review all the information you had entered in the field to ensure it is accurate. 
Be sure to check both the top portion of the screen as well as the Basic Info 
and Lat/Long tabs in the bottom part of the screen. 

2. Fill in any information you may have now that you didn’t have when initially 
creating the record out in the field. 

3. Uncheck the unaudited since Import box. 

4. Click the Save and Close button to return to the Main Menu. 

 

 

Keep in mind that because you have made changes to the records in the 
WIMS desktop, you will need to perform a GIS Export to the handheld to 
overwrite the handheld files before you do additional mapping for this area 
in the field. 
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There are 21 reports available in WIMS.  In this case, we want to see a synopsis of the 
assessment and treatment records we created in class.  The report that provides this 
information is the Assessment/Treatment, by Area report. 

 To run an Assessment/Treatment, by Area report: 

1. On the Main Menu, click the Reports button. 

2. Click the black drop down arrow in the Choose a Report field. 

 

 

Several fields now appear in the middle of the window.  These allow you to 
refine the report, limiting it to only those WIMS records that meet certain 
criteria.  The exact tabs and the fields on these will vary for each report. 

For the most part, completing these fields is optional.  However, if you 
entered data today and want your report to include that data, you must 
enter a future date in the End Date field on the Specify Start/End dates 
tab if one appears for your report. 

3. Select Assessment/Treatments, by Area. 

4. Click the Run Report button. 
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You can share your actual WIMS records with others as well.  To accomplish this, you 
will complete an Excel Export from your WIMS desktop.  And, the individual to whom 
you send your data will complete an Excel Import to load the records into WIMS on 
his/her desktop PC. 

 To complete an Excel Export: 

1. Click on the Excel Export button on the Main Menu. 

2. Click the I want to export ALL weed data on file option. 

 

 

You can instead use the various fields on the screen to Export to Excel 
window to limit the export if you wanted to export only some of the records. 

3. Click Yes on the Confirm Export Request Window. 

4. Click OK. 

5. Click the Do Export button. 

6. Locate the exported file on your computer and send it to your colleague. 

7. Instruct your colleague to follow the instructions below bring the WIMS records 
into their version of WIMS on their desktop PC. 

 To complete an Excel Import: 

1. If you don’t have a recent backup copy of your WIMS Desktop Database, make 
one now before importing new data. 

2. Save the exported Excel file to your desktop. 

3. Click the Browse button. 
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4. Locate the Excel file on your desktop. Select it and click Open. 

5. Click Do Import.  A confirmation pop-up screen will appear. 

6. If all information is correct, select Yes.   

7. On the window that displays changes/updates that were made to WIMS in the 
Import process, click OK.   

8. Click the Close button on the Import from Excel window to return to the Main 
Menu. 
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You can view your WIMS records in a GIS program.  This allows you to see the 
distribution and spatial extent of your weed infestations in a desktop GIS application, 
similarly to what you had done using ArcPad on your handheld. This is done via a GIS 
Export, although the steps are slightly different than what you had done when first 
exporting your data to your handheld. 

 To conduct a GIS Export: 

1. Follow Step 1-11 in the To perform a GIS Export section above. 

2. Uncheck the Export shapefiles to my ArcPad handheld PDA box and press 
the Create Shapefile button. 

This will create the three shapefiles into the default directory noted in the Output 
Directory for Shapefiles portion of the screen.   

 To import the files to the desktop GIS program: 

1. Open ArcMap or ArcView. 

2. Press the Add Layers button and navigate to your output directory to view the 
shapefiles. 

3. Press the Add Layers button again and navigate to your background imagery to 
view your shapefiles with the image. 
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 To exit WIMS: 

1. Press the Exit Access button at the top of the Main Menu. 


